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SECTION 00: ABOUT THE DOCUMENT 
This manual is a guide to creating land analysis products such as digital elevation models (DEMs), 2D 
orthoimages (RGB), point clouds, 3D meshes, and multispectral indices. This manual has three sections, 
including step-by-step instructions on preparing for and conducting a digital aerial photogrammetry (DAP) 
remote sensing mission and processing the data collected.  

Colour-coded text indicates different aspects of the text, such as: 

Inputs/Files 

Specific Steps/Tools 

Important Notes 

In this document, we used the Mavic 3M Enterprise drone. Depending on local aviation regulations, this 
drone may also require a pilot's certificate to fly. Pilots conducting flights mentioned in this manual are 
certified following the Canadian Aviation Regulations Part IX: Remotely Piloted Aircraft Systems (For training 
and license information, visit here.) The software used to process the images is Agisoft Metashape, which 
carries a 30-day free trial. Students may also purchase an educational license for this software. According to 
this manual, data collection requires a drone with a camera capable of capturing at least true colour (RGB). 
The drone requires additional cameras for Green, Red, Red Edge, and Near-InfraRed wavelengths to create 
multispectral indices.  

 

https://laws-lois.justice.gc.ca/eng/regulations/sor-96-433/page-110.html#h-1000299
https://tc.canada.ca/en/aviation/drone-safety/drone-pilot-licensing/getting-drone-pilot-certificate
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SECTION 01: MISSION PARAMETERIZATION 

S1.1 THE SITE 
Before the flight, it is essential to specify the boundaries of the site you intend to scan. Knowing the site's 
location, dimensions, and area informs the user of the flight time, the number of batteries needed, and 
where to find a proper takeoff/landing base for the drone. Most importantly, in Canada, you should never 
operate your drone in restricted airspace without proper clearance.  

Google Earth Pro is a free desktop application (download) for setting mission boundaries. With it, you can set 
a polygon (KML or KMZ format) to delineate the site directly on the map and gather information such as its 
surface area. 

 

https://nrc.canada.ca/en/drone-tool/
https://www.google.com/earth/about/versions/#earth-pro
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First, click the Create Polygon button. 

 

Google Earth will give you a dialogue box where you can name, stylize and measure the polygon you draw.  

 



 
7 

To draw the polygon, just start clicking the map.  

 

Once complete, name it. 
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It will now appear in the sidebar for easy access.  

 

From the sidebar, right-click the new shape and click Save Place As 
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Choose a save location and name the file if you haven't already. 
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S1.2 WEATHER 
The best scan results use sharp, evenly lit images from multiple angles. The weather, therefore, plays a 
crucial role in flight planning. Weather conditions, in particular wind, temperature, and rainfall, can influence 
factors such as safety, the number of batteries used for the flight, and, ultimately, the quality of images 
(presence of shadows and sharpness of the images) captured during the flight. 

The optimal flight condition is under overcast skies with minimal wind (ideally < 15 km/hr or 4 m/s for Mavic 
3M that weights ~ 0.95 kgs; smaller drones will be more sensitive to wind) at your flight altitude (e.g., 120m).  

Using weather apps, you will quickly find wind speed at ground level. However, at higher altitudes, wind 
speeds can be different.  

To calculate wind speed at higher altitudes, use this wind calculator.  

Simply input the wind speed shown on the app and find the altitude at which you plan to fly the drone.  

However, this is an estimate; please always refer to the wind speed reading on your controller and abort the 
mission if it is too windy to fly. 

 

If the flight takes over 1 hour, it is essential to remember that lighting conditions may vary throughout the 
day, especially under sunny, cloudless skies. 

https://wind-data.ch/tools/profile.php?lng=en
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The temperature can also impact battery performance. For the Mavic 3M, the operating temperature is 
within the range of –10 to 40 Celsius. The battery capacity is significantly reduced in low-temperature 
environments (-10 to 5 Celsius). If you are flying in those temperatures, it is important to heat the battery 
before the flight (to heat the battery, hover in the air for 3 to 5 minutes before taking off). 

NOTE: The optimal battery condition is temperatures above 20C, and keep in mind that the reduced battery 
capacity in low temperatures will reduce the drone's ability to self-stabilize for long periods. If flying below 
5C, please ensure winds are under 15 km/h. 

In an instance of rainfall, the Mavic 3M is not waterproof, but it is water-resistant. The drone may withstand 
flights in light and drizzling rain, but we strongly recommend not to attempt to fly in rainy weather. The 
drone cannot land in water. If it rains during the flight, please return and land immediately. Once landed, 
wait until the drone is fully dry before flying. 

Do not fly in extreme weather conditions, such as winds above 29 km/h or 8m/s and temperatures outside –
10C to 40C. NEVER fly in snow, fog, rain, hail, and tornadoes. 

Please refer to the Mavic 3M manual for detailed information on operating drones in different weather 
conditions.  

 

https://dl.djicdn.com/downloads/DJI_Mavic_3_Enterprise/20221216/DJI_Mavic_3M_User_Manual-EN.pdf
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S1.3 THE MAVIC 3M ENTERPRISE DRONE 
The DJI Mavic 3M Enterprise (Mavic 3M hereafter) is 
our drone of choice for completing DAP scans in this 
manual. Equipped with 5 cameras for the collection of 
true-colour (RGB), Green, Red, Red Edge and Near-
InfraRed wavelengths, the multispectral images 
collected allow measurements of reflectivity beyond 
the visible parts of the spectrum, unlocking new ways 
of seeing, surveying, and analyzing land surface 

materials such as vegetation, soil, water, and built-up areas. In section 3, we will demonstrate how to process 
multispectral images and use them for monitoring vegetation. 

It also has an integrated Real Time Kinematic (RTK) module on top of the aircraft, allowing for centimetre-
level positioning (as opposed to metre-level positioning with the on-board Global Positioning System (GPS)), 
with no or very few ground control points (GCPs). We highly recommend using an RTK, particularly for sites 
where GCPs are challenging to establish due to poor accessibility or limited operating time. This manual will 
not detail every technical specification or capability of the drone, save what is sufficient to accomplish a DAP 
mission.  

S1.3.1 CONTROLLER 
The MAVIC 3M comes with the DJI RC Pro Enterprise controller. In 
our experience, the controller performs exceptionally well within 
the 1-3km range. The battery for this controller lasts about 3 hours 
continuously. While most DAP scanning missions will be 
automated, in rare cases, taking control from the aircraft's 
computer may be necessary. For more detailed information about 
flying the drone and manual controls, DJI has created a video here: 
https://www.youtube.com/watch?v=ttJXc_Dl5ws alternatively, 
view the drone manual: 

https://dl.djicdn.com/downloads/DJI_Mavic_3_Enterprise/20221216/DJI_Mavic_3M_User_Manual-EN.pdf, 
and investigate the controller settings. 

Important buttons on the face of the controller are a back (previous screen) button, an RTH (Return To 
Home) Button, a Flight Pause button, and a slider switch for the Function, Normal, and Sport flight modes 
(remote sensing only requires the normal mode to be enabled) the power button, the 5 Directional button, 
and confirm selection button. For most scanning missions, you will only need to know how to use the 
touchscreen to work in DJI Pilot II, which is covered in the following section.   

S1.3.2 DJI PILOT II 
The DJI Pilot II application is preloaded onto the DJI RC Pro Enterprise remote controller and has been 
developed specifically for pilots of drones in the DJI Enterprise series. The app seamlessly integrates manual 
flight, mission planning and autonomous operation, making workflows highly intuitive and efficient. Upon 

https://www.youtube.com/watch?v=ttJXc_Dl5ws
https://dl.djicdn.com/downloads/DJI_Mavic_3_Enterprise/20221216/DJI_Mavic_3M_User_Manual-EN.pdf
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turning on the controller (double pressing the power button and holding the second press until the controller 
beeps), DJI Pilot II will launch automatically.  

1. PROFILE 

Flight records and offline maps are available for 
viewing and download here, along with help 
documentation and app info. 

2. PRIVACY 

You can manage network security, the app cache, 
and clear device logs here. 

3. GEOZONE MAP 

Check here to view the geo zone map, which 
provides information about whether or not your 
operating area is in an authorization or restriction 
zone, as well as the current flyable altitude.  

4. CLOUD SERVICE 

Check here for the cloud service page and view 
your connection status and type of service, or 
switch between cloud service connections.  

5. FLIGHT ROUTE 

Tap to access the flight route library. Here, users 
can view all flight tasks and create routes. Flight 
tasks can be imported and exported to the remote 
controller or external storage device. More in 
Section S1.3.3.  

 

6. ALBUM 

Limited storage on the remote controller allows 
you to save some of your photos and videos. 
However, photos and videos cannot be viewed if 
disconnected from the aircraft.  

7. ACADEMY 

On the Academy screen, you can view Enterprise 
Product Tutorials, Flight Tips, and Case Studies, as 
well as download User Manuals to the Remote 
Controller.  

8. SYSTEM MANAGEMENT 

Tapping here displays the health status of the 
aircraft, remote controller, and payload. 
Diagnostic info is displayed here, with warnings in 
red, cautions in orange, and nominal statuses in 
green.  

9. FIRMWARE UPDATE SHORTCUT 

When an update is available, a prompt will appear 
towards the bottom of the screen, allowing the 
user to update the aircraft and remote controller's 
firmware immediately.  
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10. CAMERA VIEW Tap here to enter pre-flight checks and switch 
between different camera view modes. Refer to 
Section S2.2 for more info on pre-flight checks.  

S1.3.3 FLIGHT PLANNING 
This section covers key steps when using the DJI Pilot II controller. We have outlined specific steps below to 
demonstrate how to import and parameterize flight missions using the controller.  

First, open the app (or turn on the controller) and tap the "Flight Route" button outlined in the screenshot 
below.   

 

Once here, you can create a new mission or repeat a previous flight. Previous flight parameters are also 
editable if minor changes, such as revising site boundaries, changing the flight altitude, etc., are needed.   

Based on our field experiences, we recommend completing the following steps indoors, ideally, the day 
before the mission, to allow ample scanning time for the mission. 

If you are creating a new mission, press the "+" icon at the top right.  

If you have an already existing KMZ/KML file of the mission (such as the one made in Section 1.1) from 
Google Earth Pro, you can transfer it directly from your computer to the controller using an SD card  

Import Route (KMZ/KML)  
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Locate your KMZ/KML file on the SD card. 

 

Select Area Route to start planning the parameters for the mission. 

 

The Area Route is named using your KMZ/KML file (e.g., DAPKMZ). In this window, you can edit the image 
collection methods, GSD, Altitude mode, etc. See the screenshot below.  
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Alternatively, press Create a Route after entering the Flight Route library to create a new mission without 
using a pre-defined KML/KMZ file. 

 

Select Area Route. 
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After selecting Area Route, you will enter a map screen (see below).  

Start tapping on the map to add vertices and draw a polygon around the area you plan to scan.  

 

Next, DJI Pilot II will ask you for your drone and camera models – Our drone is a Mavic 3 Multispectral, so we 
selected the M3E Series in the Aircraft Model box and M3M in the Camera Model box. To activate all 
available cameras on the flight, Tap the RGB and MS boxes. Once this is completed, press OK.  
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This will bring you to a new screen with more flight parameters. A new menu will appear on the right-hand 
side of the screen, with the mission's name, drone and camera models, and selected cameras for the 
operation.  

Two collection method options are available here. The choices are Ortho Collection and Oblique Collection.  

Ortho Collection is only a nadir scan (the camera is pointed straight down for the duration of the flight 
mission, resulting in an orthographic image where every pixel is at the same scale). However, nadir views are 
typically inadequate to capture necessary pixels under dense canopies and on building façades.  

We recommend using Oblique Collection whenever possible to improve the quality of subsequent point 
cloud and 3D mesh model constructions. For our scans, we selected Oblique Collection. 

 

Oblique Collection consists of 5 automated flight routes: Route 1 is nadir, while routes 2, 3, 4, and 5 fly at 
each of the four angles relative to the course angle of the initial flight route.  

This collection method will increase the flight time and number of images captured. For other Enterprise 
drones with only RGB sensors, we recommend using Smart Oblique.  Smart Oblique utilizes the camera 
gimbal to perform the same mission as a regular Oblique Collection but with only two perpendicular flight 
routes.   

Ortho GSD refers to the Ground Sampling Distance (GSD), or the distance (typically in centimetres) between 
the centres of two neighbouring pixels of an orthographic image.  
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A flight altitude of 108.4 metres ASL results in a 5cm GSD for Mavic 3M while using the multispectral cameras 
(see screenshot below, GSD = 5.00). This altitude references the takeoff point, typically a level surface on the 
ground within (or nearby) the mapping area. 

 

For the oblique flight route, you need to set the gimbal pitch, which adjusts the angle at which the camera 
points toward the ground. Typically, with a higher gimble pitch, the camera can capture wall surfaces more 
accurately during the scan. For sites with more vertical features (e.g., tall buildings, large tree canopies), we 
recommend a pitch value between -45° and -70° (see screenshot below).  

 

Next, we will set the drone's takeoff altitude and course angle. Safe Takeoff Altitude refers to the altitude at 
which the aircraft will start to fly toward the starting point of the flight mission. This altitude should be higher 
than any obstacles between the drone and the starting point but lower than the maximum allowed. For 
Canada, it is 122 meters. 
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Maximizing Speed increases flight efficiency during data collection (this differs from the takeoff speed and 
refers only to the drone's Speed when flying along a route).  

The default course angle is in line with the length of the polygon used to demarcate the scanning area (in the 
case of the university scan, the course angle defaults at 243 degrees). See the screenshot below. 

 

Next, Tap Advanced Settings to adjust photo modes and overlap. You can change the amount of image 
overlap in the advanced settings section. For Route 1 (ortho collection), we chose 70% Side Overlap and 80% 
Frontal Overlap. For Route 2-5 (Oblique Collection), we decided on 60% Side Overlap and 70% Frontal 
Overlap 
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Once you have specified the desired image overlaps, 

Scroll down the menu -> set the photo mode, camera angles, and takeoff speed 

The Takeoff Speed, different from the previous steps, specifies the Speed at which the drone travels after 
reaching the takeoff altitude to reach the mission starting point. You can also adjust the flight's initial position 
by  

Pressing "set" in the "Route Start Point" row 

Remember that while the settings are open during mission planning, the flight duration and number of 
photos required (listed as "Estimated Storage") are shown for EACH ROUTE and are NOT the total.  

To make any final adjustments and save the mission:   

Press the floppy disk button in the top left of the screen to save the mission. You can then access the mission 
directly from the Flight Route Library. Again, we recommend completing this step the day before the mission 
whenever possible. 
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The screenshot below is the screen you will see when you click on the flight plan from the Flight Route Library 
screen. The values in the top left show the estimated total time (6m 45s) and the number of images (204) the 
drone will capture.  
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SECTION 02: FLIGHT EXECUTION 

S2.1 FLIGHT PREP 
Before the flight, you recommend using the following list to ensure all necessary settings and equipment are 
ready: 

• The controller is fully charged. 
• The correct number of fully charged batteries is based on flight time (Estimated). (Each battery is 

good for 35-45 minutes). 
• The propellors are in good shape; you will see the blades have orange tips, and if they are visibly 

cracked beyond the orange colouring or show other signs of wear, change them before the flight. 
• Sufficient empty SD card(s). 
• The flight route is planned and saved in the controller.  
• Takeoff/landing location(s) are accessible.  
• RTK (if available) is fully charged. 

 

As mentioned, finding an appropriate base for the drone to launch and land again is essential. While the 
home base does not necessarily need to be within the mission area, we recommend finding a home base that 
is nearby (< 1km).  

The landing surface must be flat and clear of debris to prevent foreign objects (such as small rocks) from 
projecting from the ground unexpectedly. This means you cannot launch on grass fields, sand, pebbles, etc. 
The drone needs a fixed home base to return to, so moving objects cannot be used to record a home point. 

Proceed to unfold the arms, remove the gimbal cover, and connect the drone and RTK to the controller. Place 
the drone on the chosen home base and get ready to launch. Place the RTK within proximity (5m) to the 
home base and away from tall, large objects such as buildings or trees. 

Before launching, ensure there is no warning from the controller. 

Be extra cautious when operating near residential areas, large water bodies, and dense forests.  

 

S2.2 LAUNCH 
The mission will be fully autonomous. Typically, using the joysticks will not be necessary during the mission. 

After launching the drone, the home base will be marked ("H") on the controller map. The operator(s) must 
stay near the base to access the drone upon mission completion or change batteries between flights during a 
mission. 
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S2.3 FLIGHT MONITORING 
When the drone is in the air, it is mandatory in Canada to maintain a visual line of sight (VLOS).  

It is a critical safety measure that prevents accidents and maintains drone control. Therefore, we recommend 
having a partner monitor the controller and maintain VLOS during each flight.  

Completed parts of the flight mission appear as grey paths on the map screen on the controller, while the 
current route appears green.  

On the controller, there are several values that the operator needs to be aware of and constantly monitoring, 
as annotated in the screenshot below:  
 

1. Number of satellites connected  
2. Controller signal strength  
3. The remaining battery percentage for the drone and the controller  
4. Real-time location of the drone and its Speed, altitude, flight direction, and distance to the home 

base 
5. Wind speed 
6. Remaining flight time 
7. Remaining number of flights (if more than one flight in a mission)  
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SECTION 03: POST-PROCESSING 
So far, you have learned how to set mission areas using Google Earth Pro or the DJI Pilot II App and know how 
to execute a planned mission safely. This final section will describe the post-processing steps in using the 
collected images to create point clouds, Digital Terrain Models (DTMs), Digital Surface Models (DSMs), 
orthorectified photos, 3D meshes, and multispectral indices.  

We will use Agisoft Metashape (AM, or Metashape hereafter) and QGIS for image post-processing. There are 
many other alternative programs; we chose Metashape and QGIS for their relatively low costs, computing 
performances, and usability.  

 

S3.1 FILE SORTING 
When the drone writes the image files to an SD card, it automatically creates folders named after the 
mission's name (e.g., F-240612) during the parameterization phase. The system creates a new folder when a 
mission is paused and then resumed (e.g. when the drone returns home for a replacement battery).  

This means multiple flights may occur during a single mission. A flight is any time the drone leaves to perform 
a flight route (in whole or as part of a mission) and returns to the home point. Therefore, the drone stores all 
the images taken during a mission with more than one flight in multiple folders, each folder name 
corresponding to each flight. These folders require sorting before being taken into Metashape (See 
screenshot below).  
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By default, the files are organized within each folder based on their file type, with mission-related non-image 
files appearing first and images organized by date and type thereafter.  

For Mavic 3M, each image capture (i.e., one shutter count) will result in 5 images (1 RGB image in JPEG 
format + 4 multispectral (MS) images in TIF format). The drone writes multispectral images with a suffix that 
matches the name of the spectral band: Green (_G), Near-infrared (_NIR), Red (_R), and Red Edge (_RE). RGB 
images will have a _D as a suffix.  

See the screenshots below showing 6 captures, resulting in 6 RGB images + 6x4 MS images. 

 

We recommend the following folder structure to organize these images. First, make a parent mission folder 
following the date and mission number nomenclature (F_YYMMDD_X).  

 

 

Inside this folder, create a new folder labelled INPUT.  
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Create two folders for the RGB and MS images inside the INPUT folder.  

 

Inside the MS folder, create four folders for each spectral band.  

 

  

Below is a visualization of the File Explorer directory:  

F_YYMMDD_X  
> INPUT  

> RGB 
> MS  
  > G 

> R 
> RE 
> NIR 
 

To begin sorting the photos, return to the SD card and open a flight folder. Use the search function at the top 
right of the File Explorer screen to search the suffix of the files you want (e.g., _RE for MS Red Edge images). 
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NOTE: Searching for _R will include _RE files. To prevent that, search for the files with quotations (e.g. "_R") 

 

CTRL+A to select all the items you searched. Click and drag from the flight folder to the corresponding 
destination folder you created.  

Once you have finished creating and filling the INPUT folder directories, return to the F_YYMMDD_X parent 
folder and create an OUTPUT folder to store data exported from Metashape and QGIS.  

  

S3.2 METASHAPE 
Metashape is available for 64x Windows PC and Mac OS for a 30-day free trial at the time of preparing this 
document. Due to the intensive workload, we highly recommend computers with a dedicated desktop 
Graphics Processing Unit (GPU).  

After downloading, launch the program. There are four main compartments in Metashape's user interface:  

• toolbar (yellow) 
• workspace/references/properties panel (W/R/P, green  
• console (blue) 
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• renderer (red) 

 

The W/R/P panel is preloaded with an empty chunk. Chunks in Metashape are workload organization tools 
that allow you to process different batches of images. We recommend separating RGB images and MS images 
into two individual chunks. Label them accordingly.  

To set up the file for MS images,  

Rename the existing chunk to "RGB" by right-clicking it. 

Right-click in the workspace and click Add Chunk.  

Renderer 

Console 

Toolbar 

W/R/P 
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Rename the new chunk to "MS," and your Metashape file will now be ready to receive its first batch of 
images!  

Save the Metashape project (.psx) before moving on (Ctrl + S). 

The file naming nomenclature (F_YYMMDD_XX) discussed earlier in S3.1 also applies here. Once that is 
completed,  

Double-click the RGB chunk to ensure it is active.  

An active chunk's name will be bold (see screenshot below).  
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To import RGB images: 

Click Workflow in the toolbar and click Add folder.  

 

Navigate through File Explorer to the RGB INPUT folder you created earlier for the flight you wish to process.  

Click to highlight the folder, and press Select Folder.  

 

After Metashape loads the images,  
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Select single cameras in the dialogue box. 

 

Metashape will place your images into the RGB chunk.  

Note that the chunk now displays the number of images (340) it contains.  

CTRL + S to save the project before continuing. 

Repeat the same steps for the MS chunk, except add the MS folder. When the Add Photos dialogue box pops 
up,  
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Click Multi-Camera System. This organizes the photos using the spectral subfolders we made in the MS 
folder.  

 

After every following section, Ctrl + S to save the project 

S3.2.1 PHOTO ALIGNMENT 
Once the image chunks have been loaded into Metashape, the first task for Metashape processing is aligning 
the photos and creating a sparse point cloud.  
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Click Workflow in the toolbar and Align Photos 

Set the Accuracy to Highest -> Reference preselection: Source.  

Advanced -> Check all the boxes  

 



 
35 

Press OK. Metashape will immediately start the alignment process. Depending on the number of images and 
your computer hardware, this process can take up to a few hours to complete.  

 

 
 

 

 

S3.2.2 GEOREFERENCING 
Metashape will generate a sparse point cloud labelled Tie Points. (see screenshot below). These Tie Points 
are the result of the photogrammetry alignment process. However accurate the Tie Points appear, the point 
cloud as a whole is often incorrectly geographically located. 

 

 

Georeferencing our point cloud is necessary for it to reliably interact with other mapping software for 
operations such as a higher resolution aerial image, spatial analysis, and especially for time series. We will 
georeference our scans by establishing a series of Ground Control Points (GCPs) in QGIS. 

QGIS is a free desktop application (download) for working with raster and vector data. Within it, we will be 
creating the vector GCPs which we use to georeference our scans.  

https://qgis.org/download/
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Ground Control Points (GCPs) are physically marked points which act as reference points for our 
photogrammetry and point cloud alignment. Within the point cloud, dimensions and proportions of the scan 
remain clean. The point cloud however, is often offset from the correct geographic position. The GCPs mark 
the correct geographic position of each reference point, and we align our point cloud model to these points. 

 

To create Ground Control Points (GCP) 

QGIS -> new shapefile layer -> Point  

Make sure you have UTM zone 14N selected for Winnipeg.  
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To create the points, first click on the pencil, then add point feature 

 

We are now able to plot our Ground Control Points. Some things to consider when selecting the markers that 
depict when the GCPs are: 

I. Select markers that are stable and constant in position (avoid tree canopies) 

II. Select markers that are high contrast (easily discernible from an aerial image) 

III. Select markers that are precise enough for the task (smaller diameter = greater precision) 

 

After placing the Ground Control Points in their respective locations, we must now assign their individual X, Y, 
and Z coordinates for Metashape to recognize them. 

In the Attribute Table, we see each point and it's identifying number. To begin giving the points their 
geometries we must first open the field calculator: 

 

Field Calculator -> New Field  

The Output field type for all dimensions is Decimal Number (real). 

To assign the X and Y geometries, simply type $X and $Y accordingly in the expression box.  

 

Output field name: X 
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Output field type: Decimal Number (real) 

Expression $X 

 

 

Output field name: Y 

Output field type: Decimal Number (real) 

Expression $Y 

 

 

To assign the Z dimension, we must manually measure the DSM and input the recorded Z value.  
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With editing enabled (yellow pencil icon), create a New Field in the attribute table titled "Z". Ensure it is also 
a "Decimal Number (real)" type. 

 

 

 

The new "Z" column should be "NULL". We will be manually inputting the Z values. 

 

 

 

To capture the Z values of each GCP, we will be measuring a Digital Surface Model (DSM).  

To measure the DSM: 
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Select the DSM layer in the layer panel -> Click on the information tool on the attributes toolbar 

 

 

Zoom to GCP location -> Click on DSM tile under GCP -> Record Band 1 value -> Input into "Z" column 
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Repeat this process for all GCPs. The final attribute table should appear as so: 

 

 

Once complete, we must now export the point shapefile into a format Metashape can read.  

Right click on GCP layer -> Export -> Save Features as 

 

Format: CSV 

CRS: 32614 

Encoding: UTF-8 
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The GCPs have successfully been placed, recorded, and exported for use in Metashape. 

 

To import the GCPs into Metashape: 

View -> Panes -> Reference -> Import Reference 
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Ensure Import CSV appears as image below: 

 

 

 

 

Next, we must Transform the Camera Reference: 

Reference -> Settings (Hammer and Wrench icon) -> Click Camera Reference -> Change from 32614 to 4326 
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The GCPs are now correctly transformed and are ready to align our sparse point cloud. To prepare the 
georeferencing interface: 

View -> Panes -> Photos 

 

Markers Panel -> Right click on a marker -> Filter Photos by marker 

 

 

To reference the selected marker: 

Double left click on a photo -> Zoom in -> Left click and Drag marker flag to GCP location 

Alignment is recorded once both marker flag and image icon flags turn Green 
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After the first GCP Flag is set, a few images may lose the white flag next to them. This means the software 
realizes the GCP is not in the image's frame, and has disqualified it. Ignore images with no white flag. 

The first few flags solidify the GCPs position, and the others reinforce this location. This means you should 
should be most precise with the first few flags, or else the catching up required with the remaining flags will 
skew the resulting accuracy. 

You may notice that the first images are often plan view, and the further down the list to more oblique the 
images are. To receive the best georeferencing results, reference flags using a combination of plan and 
oblique images. 

 

For each GCP, set at least 4 - 6 green flags 

Repeat for all GCP's 

Once flags are set, click on (refresh logo) -> Update Transform 
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In the markers panel, the columns to pay attention to are: 

I. Error: How offset the point cloud is from the GCPs 

II. Projections: The number of flags referencing the point cloud to GCPs 

If you see a considerable Error(m) value (greater than 10cm), it is likely a couple of markers skewing the 
accuracy of the point cloud. Scroll through the markers searching for outliers and realign accordingly. Ensure 
you Update Transform after this process. 
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S3.2.3 POINT CLOUDS 
The new sparse point cloud often requires some cleaning before generating a dense point cloud. Use the 
gimbal ball in the renderer window to rotate the camera view so that the point cloud appears level. You will 
notice large clusters of outlying points below the ground or way above the tallest structures in your scan. 

 

To remove these points from your sparse point cloud: 
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Click Tools in the toolbar -> Tie Points -> Clean Tie Points 

 

Click the Criterion drop-down menu and select Reprojection error.  

Specify a value and Press OK.  

We found that a value of .5 was sufficient to clean most erroneous tie points (selected points appear as pink 
colour points). 

 



 
49 

Once you have made your selection,  

Navigate to Edit in the toolbar -> Delete Selection.  

Alternatively, press Delete to remove these selected points. 

 

Go back to the Clean Tie Points tool -> Reconstruction uncertainty  

For this value, we chose 10. This makes 10 the highest level of uncertainty for the sparse points.  

Delete the selection 

 

 

Again, go back to the Clean Tie Points tool -> Projection accuracy.  
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This value should be around 20-10; however, 10 is a very aggressive selection range and may cause problems 
when creating the dense point cloud. 

 

 

 

 

The sparse point cloud is noticeably cleaner and conforms more to the real-life geometry of the scanned 
area. To optimize the tie points even further,  

Tools -> Optimize Cameras.  

 

 

 

Check the Adaptive camera model fitting and estimate tie point covariance under the advanced settings in 
the new dialogue box.   
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Press OK. 

 

 

Any obvious remaining points must be cleaned up manually using the marquee tool in the toolbar.  

 

Manually select and delete any remaining outlying points. 
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An addittional method for manually deleting outliers involves changing the visualization of the tie points from 
their RGB value to their Elevational value. 

First, we change the interface to a dark background to see the points better.  

Tools -> Preferences -> General Tab -> User interface -> Theme: Change to dark 

 

Then we change the tie points visualization. 

Toolbar -> Tie Points -> Click on Drop Down arrow -> Change to Elevation 

 

 

 

 

 

 

We have removed 109,570 points through our filtering. Note that the parameters used in this document 
might not work well in your scan. Experiment with different values and compare the quality of the dense 
point cloud afterwards.  

Now that that sparse point cloud is cleaned up, we can start building a dense one. 
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Workflow -> Build Point Cloud 

 

Quality: High -> Depth Filtering: Mild 

Check off both Calculate Point Colours and Point Confidence  

 

 

 

Press OK 
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The dense point cloud generation consists of two parts. First, Metashape generates depth maps and then 
generates points calculated from the depth maps. The entire process might take 2-3 hours, depending on 
your computer hardware, processing quality settings, and the number of images. 

After completing the dense point cloud,  

Double-click Point Cloud under the Workspace panel to render the dense point (see screenshot below).   

 

Hit "CTRL+S" to save the project before moving on.  
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S3.2.4 DEMS 
After creating the dense point cloud, we can generate Digital Elevation Models (DEMs). A DEM is a raster 
image containing a height measurement value for each pixel.  

Workflow -> Build DEM  

 

 

The DEM dialogue box contains reference and projection options. 

Make sure Geographic is selected and the appropriate projection of the scanning location is selected. The 
default projection in Metashape is WGS 84 (EPSG:4326). To change this,  

Click the drop-down and select more. Search for the correct coordinate system, select it, and press OK. 
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Set the interpolation option to Extrapolated.  

Click OK. 

The DEM will take some time to process. 

 

Once complete, you will have a coloured elevation model. Since this model does not exclude any objects, it is 
referred to as a Digital Surface Model. To create an elevation model that only measures the ground surfaces 
(Digital Terrain Model), we must classify the points before we build another DEM.  
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Click Tools -> Point Cloud -> Classify Ground Points.  

 

 

In the Classes -> From box, select Any Class. The angles and terrain slopes help Metashape determine a 
ground point; for the university scan, 10° was sufficient. Set erosion radius to 0.  

 

Click OK and allow the process to complete. 
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Complete the same steps to create the DTM we used to generate the DSM, except after setting the 
interpolation to extrapolated; we will click select in the point classes row. Then, uncheck all boxes except for 
ground. 

 

 

 

Click OK in the Select Point Classes dialogue box and then click OK again in the Build DEM dialogue box. 

The resulting DEM will be generated using only the ground points.  
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Ctrl + S to save.  

S3.2.5 ORTHOIMAGERY  
Once you have generated a DSM, you can create an orthomosaic.  

To do this, select the DSM so that it is in the renderer window.  

 

Click Workflow and select Build Orthomosaic. Metashape will automatically use the DEM as the reference 
surface. 
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 Check off the Refine Seamlines and Enable Ghosting Filter boxes and Press OK. 

 

Again, it will take some time for Metashape to process the Orthomosaic, often up to a few hours, depending 
on computer hardware. 
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The resulting orthomosaic will show the final GSD resolution on its tab in the Workspace panel.  

 

Repeat the same Build Ortho processes for the multispectral chunk. 

Note: you must generate a DSM in the multispectral chunk before building the multispectral orthomosaic. 

S3.2.6 3D MESH 
The final digital product of the photogrammetry scan is a 3D model.  

Start by clicking Workflow 

Select Build Model.  

Metashape uses the depth maps created during point cloud generation to reconstruct the images into a 3D 
mesh.  
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In the Source Data row, make sure Metashape uses depth maps; this is the most accurate reconstruction.  

Set Quality and Face Count to high if they are not already. 

Press OK, and the 3D model will be generated, again taking up to a few hours, depending on the computer 
hardware. 

 

 

S3.3 MULTISPECTRAL INDICES 
One of the critical features of the Mavic 3M is the ability to capture multispectral images. Multispectral 
imaging measures specific ranges of wavelengths (see table below) in the electromagnetic spectrum (EMS), 
some of which are not visible to the human eye. These measurements complement the visible (RGB) images, 
offering insights into materials (vegetation, impervious surfaces) that are difficult to detect with conventional 
optical cameras. The drone measures these wavelengths and creates 4 individual raster bands (channels).  

Band name  Wavelength (nm) 
Green (G) 550 ± 16 

Red (R) 650 ± 16 
Red (RE) 730 ± 16 

Near-Infrared (NIR) 860 ± 26 
 

These bands can be further combined and manipulated to generate multispectral indices, highlighting surface 
characteristics with more manageable data ranges and interpretability. For example, the Normalized 
Differences Vegetation Index (NDVI) is a multispectral vegetation index that uses the R and NIR bands to map 
the quantity and quality of vegetation against other types of surface materials such as soil, bare ground, and 
buildings.  

We use a built-in QGIS function called Raster Calculator to compute these indices. For this tutorial, we will 
use NDVI as a demonstration.  
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Download F_240627_MSOrtho_forTutorials.tif and import it to QGIS. This file covers part of the University of 
Manitoba's Fort Garry Campus.  

Tip: drag and drop the image (.tif) file directly onto the map canvas.  

Your QGIS window should look like the screenshot below. You will see that the imported file in the layers tab 
has 3 bands. 

This image consists of the 4 different spectral bands mentioned earlier.  

Please check if you have the correct number of bands:  

Right-click the image name -> Layer Properties -> Symbology -> Render type: change to single-band 
pseudocolour. (see screenshot below).  

 

The order of these bands is crucial to the equation performed in the raster calculator. The order goes as 
follows: 

Band 1 = G, Band 2 = R, Band 3 = RE, Band 4 = NIR. 
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Once this is finished, if you can click on the bands, you should see 5 bands. Band 5 is the alpha band and will 
be ignored in the following process. 

Exit Layer Properties.  

EXTRA: 

To render the original image file into a false-coloured image:  

Change the bands accordingly: 

Layer properties -> Symbology -> Render type: Multiband Color 

Red band = band 4 

Green band = band 2 

Blue band = band 1 

And it should look like this:  

 

Because we used the colour red to render NIR (band 4), as a result, surfaces that reflect a lot of NIR, such as 
vegetation, will be rendered red.  

 

https://earthobservatory.nasa.gov/features/FalseColor
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Now, let's use this multispectral image to compute NDVI.  

The equation for the NDVI is:  

NDVI = (NIR – R) / (NIR + R) 

Typically, NDVI values range from –1 to 1.  

Proceed to the Processing toolbox -> type "Raster calculator". You will be given 2 types. Choose the "Raster 
Analysis -> Raster calculator." See the screenshot below.  

 

Once you open the raster calculator, click the "..." box on the right 

 

Select the TIF file as the Input Layer, then OK 

 

Copy the equation below and paste it on the Expression box 

("F_240627_MSOrtho_forTutorials@4"-
"F_240627_MSOrtho_forTutorials@2")/("F_240627_MSOrtho_forTutorials@4"+"F_240627_MSOrtho_forTut
orials@2") 
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The equation is written as "TIF@band x." For example, F_240627_MSOrtho_forTutorials@4 means the 4th 
band in F_240627_MSOrtho_forTutorials.tif 

 

Next, click on the "..." on the right of the calculated box -> Save to File …Navigate to the folder where you 
want this image to be saved -> Name the file -> Save. 

See the screenshot below; we called this F_240627_NDVI.tif in this tutorial.  
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After, check your Raster Calculator and make sure all required parameters are entered correctly. 
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Click "Run." The resultant image is a black and white raster with white showing higher NDVI values. Below, 
we used a more vibrant colour ramp to visualize NDVI.  
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To increase the contrast of NDVI images, we will reset the colour scheme to highlight NDVI ranges with more 
variation. To do so, we can use the histogram to examine the distribution of NDVI values.  

Right click F_240627_NDVI.tif -> Layer Properties -> Histogram -> Compute histogram The Pixel Value (x-axis) 
represents the range of NDVI values within the image, while the Frequency (y-axis) represents the number of 
pixels in those ranges. Based on the histogram below, we can see the most variation and the number of 
pixels when NDVI is between approximately -0.3 and +0.8 (red arrows shown in the screenshot below).   

 

Now, follow the steps below to change the symbology.  

Layer properties -> Symbology -> Render type: change to single band pseudocolour.  

Change the values based on the histogram: min to –0.3 and max to 0.8 

Feel free to choose a colour ramp to your liking. 
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After changing the values,  

"Apply" -> "OK". 

Below, you can see the difference between the change in values. 

 

You have now successfully created a spectral index! 

To better interpret NDVI, a graph of its values is shown in relation to true colour images.  


